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1. Introduction 

1.1. What is VidaOne Diet & Fitness? 
VidaOne Diet & Fitness™ is the premier application designed to help you track and improve 
your health, fitness and nutrition. It can be used for a variety of reasons: 
 

• Follow a diet to lose or gain weight 
• Monitor the food you consume 
• Track specific nutrients such as glucose, cholesterol, etc. 
• Keep a detailed log of all your activities including cardio-vascular workouts (walking, 

running, bicycling, swimming, etc) and strength-training (free weight, barbell, dumbbell, 
machine, ball, etc.) 

• Track your progress toward the completion of a workout goal 
• Enter health vital signs and other information such as body measurements and blood 

markers. 
• Print various reports to present to medical staff, doctors, etc. 
• Synchronize data with MySportTraining® and MyPersonalDiet® (more on this later). 

 
VidaOne Diet & Fitness can be used by one or several people, and each user’s data can be 
protected via passwords. It is ideal for the whole family or a coach. 

How to Personalize VidaOne Diet & Fitness 
You can customize VidaOne Diet & Fitness to suit it to your needs. You can not only change its 
appearance, but you can also create any type of information you want to track (equipment, vital 
signs, etc.) The following table lists the features that can be customized and the page that 
contains more information for each feature. 
 
Features Page 
Create your profile (to allow multiple users to use VidaOne Diet & Fitness) 7 
Starting a diet 19 
Monitor specific nutrients 75 
Configure the food database 24 
Create your own fields to track any type of information 38 
Create your own activities 41 
Specify parameters for exact calorie expenditure calculation 41 
Set graphic options 73 
Change appearance (color scheme) 74 
Select unit system (English or Metric) 75 
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1.2. Using a Heart Rate Monitor 
VidaOne Diet & Fitness allows you to download workouts from most Polar® heart rate 
monitors, and to visualize key information about your training. It also makes it much faster to 
enter workouts, as most of the information is automatically entered for you. 
 
You can find more information about Polar® heart rate monitors by visiting: 
http://www.polarusa.com. 

1.3. Using a Windows Mobile Pocket PC or Palm OS Handheld Device? 
VidaOne Diet & Fitness synchronizes with MySportTraining® and MyPersonalDiet® for Pocket 
PC and for Palm OS. MyPersonalDiet provides most of the diet and food tracking from VidaOne 
Diet & Fitness, whereas MySportTraining contains most of the fitness features found in VidaOne 
Diet & Fitness. Both applications are integrated and they share data on your device. This makes 
it ideal to track your food and workouts on-the-go. Seamless synchronization then brings all the 
data to your PC (desktop or laptop) into VidaOne Diet &Fitness. 
 
For Windows Mobile Pocket PC, the synchronization is achieved via Windows Mobile Device 
Center (on Windows Vista) and ActiveSync (on Windows XP). For Palm OS handheld, the 
synchronization is implemented as a HotSync conduit (for both Windows Vista and XP). 

1.4. Technical Support 
You can obtain more information about our products, updates, etc. by visiting our Frequently-
Asked Questions (FAQ) page at: http://www.vidaone.com/faqs.htm.  
 
If you have a question, or want to provide some feedback or just a comment, please send us an 
email at: support@Vidaone.com. 
 
You can also contact us by mail at the following address: 
 

VidaOne, Inc. 
2501 W. William Cannon Dr 
Bldg 2, Suite 205 
Austin, TX 78745 
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2. Quick Tour 
The VidaOne Diet & Fitness main screen is shown in Figure 1.  
 

 
Figure 1: VidaOne Diet & Fitness main screen under Windows XP. 

 
The application menu and toolbar allow you to access the different features of the applications. 
  
The main area underneath the toolbar is the current view area. It displays the current view’s 
content. Views are explained in details in the following pages. 
 
Toward the bottom left corner is the view navigation area, which allows you to quickly jump 
from one view to another.  
 
Above it is the current view’s options, which depends on the view being shown.  
  
To exit VidaOne Diet & Fitness, select Exit from the File menu. 
 

Current view’s options 

Application menu and toolbar 

 
 
 
 
 

Current view area 

View 
navigation 

area 

Click here 
to add data. 
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3. Profiles 

3.1. What Is a Profile? 
VidaOne Diet & Fitness is designed to store diet, food workout, health records and personal 
settings for multiple users. Each user is assigned a profile, and as many profiles as you want can 
be created. For instance, if John and Mary are going to use VidaOne Diet & Fitness, each should 
create his or her own profile, respectively called “John” and “Mary”, and select it when using 
VidaOne Diet & Fitness. Using his profile, John will only see his workout; using her profile, 
Mary will only see hers. Passwords can be assigned to each user to make sure that any user only 
has access to his or her data only. See section 3.3 for more information about confidentiality. 
 
Only one profile is active at any moment, and the current profile is shown in the title bar next to 
“VidaOne Diet & Fitness”. For instance, in Figure 1, the title bar indicates that the profile for 
“John” is the current. 

3.2. Creating Profiles 
The Welcome wizard, shown upon starting VidaOne Diet & Fitness for the first time, will 
prompt you for a profile name, among other information. Even if you will be the sole user of 
VidaOne Diet & Fitness, a profile is required. It is best to enter your first name, but you can enter 
any name you want. The profile remains active until you select another profile (described 
below). You can create additional profiles (one for each member of your family, for instance) by 
choosing New from the File menu, and clicking A profile (see Figure 2). Simply enter the name 
of the new profile and click OK. This will create the profile and make it current. 
 

  
Figure 2: Creating a profile. 

Make sure this button is 
selected in order to add a 
profile. 
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To select another profile, select Open Profile from the File menu, or click the Profile icon in the 
tool bar. This will show the Profiles window (see Figure 3). Simply select the profile to open and 
click OK to make this profile the current.  
 

  
Figure 3: The Open Profile window, which allows you to select another profile and make it current. 

You can edit or remove an existing profile. Note that since VidaOne Diet & Fitness requires at 
least one profile, it is not possible to delete a profile unless there is another one to use. 

3.3. Profiles Confidentiality and Security 
Profiles data can be kept confidential by requiring each user to enter a password when opening 
their profile. To enable security, click Tools | Options | Other tab and select the Enable 
security checkbox. Upon enabling security, you will be prompted for a password to secure your 
data. Your profile automatically becomes the Administrator profile, giving your profile (and 
your profile only) the right to perform the following actions: 
 

• Disable security 
• Create, edit or delete profiles 

 
Note 

 
Make sure to write down your password. If it is lost, you will not be able to access 
your data nor perform the actions listed above. 

 
Once the security is enabled, the other users will be prompted to enter a password when opening 
their profile, as shown in Figure 4. 
 
Passwords can be changed in the Open Profile window. When security is enabled, a password 
button  is shown and allows the password to be changed for the selected profile. 
 

Click this button to edit 
the name. You can also 
click once on the name to 
edit it. 

Click this button to 
remove the profile. 

The PDA symbol 
represents the user whose 
data is synchronized 
with. See page 72 for 
more details. 



VidaOne Diet & Fitness for Windows User’s Guide 9 

To disable security, open the Administrator profile,  click Tools | Options | Other tab and clear 
the Enable security checkbox. 

 
Figure 4: When security is enabled, users must enter a password to access their data. This ensures that user’s 

workout and health data remain confidential. 

 
There are a few topics to take into account when enabling security: 
 

• Only the user who enabled the security can later on disable it. Under any other profile, 
the checkbox Enable Security in the Tools window will be disabled (grayed). This 
ensures that none can disable security but the user who enabled it. 

 
• After turning on security, it is recommended to open each existing profile immediately in 

order to assign passwords (because once security is enabled, opening a profile the firs 
time requires entering the password). This ensures that each user’s data is protected. 

 
• Upon opening VidaOne Diet & Fitness, the Profiles window is shown and the user must 

select a profile (and enter a password) as shown in section 2. Without security, the last 
profile used was immediately opened. 

 
• Upon launching VidaOne Diet & Fitness, if it is detected that the security has been 

tampered with, the user who enabled the security will be required to enter his/her 
password, and then security will be disabled (since passwords might have been modified 
and/or removed). Security must be turned on again and passwords must be entered for all 
existing profiles (as described above). 

 
• It is crucial the administrator password is not lost, because VidaOne Technical 

Support cannot recover it. 
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4. Views 

4.1. The Summary View 
The Summary view (see Figure 5) presents an overview of your weight and activities: 
 

• The Body Weight shows your body weight or the progression of your diet. 
 

• An activity summary list shows, for each activity, the number of workouts, the total 
time, and the number of calories for the current period (note that the number of calories is 
not shown in Figure 5 because the window has been resized to its minimum size). 

 
• A pie chart represents the time spent across the activities listed in the activity summary 

list. This allows you to quickly see how you split your workout time across your 
activities, which is very valuable when participating multiple activities. 

 
• A training time graph shows the time spent exercising for the selected period. 

 

 
Figure 5: The Summary view shows an overview of your body weight  

(or diet), and workouts for a given period.  
 

Click here to 
change the period. 

Click here to see 
different graphs. 

Click here to change 
the sort order. 

Click here to choose 
another picture. 
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4.2. The Journal View 
The journal view shows the meals, workouts and health information for a given day. It also 
presents a daily summary (at the bottom on Figure 6) consisting of four different charts: 
 

• Energy balance, showing the amount of energy consumed (by meals) and spent (via the 
BMR and workouts). 

• Energy breakdown, showing a pie that presents where the energy came from among 
carbohydrates, proteins and fat. 

• Nutrients tracking, which allows you to select any nutrient and see how much you 
consumed. If you set min/max limits (see section 5.2), they will also be shown. 

• A summary list of the nutrients consumed for the day. 
 

 
Figure 6: The Journal view shows meals, workouts and health information for the day. 

 

Select here what 
panels to show. 

Various daily charts are available. 

Days in bold 
indicate days 
with data. 

Click here to go to the previous, 
next or current day. 

Double-click on an 
item to edit it. 
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4.3. The Calendar View 
The Calendar view shows a monthly summary of your meals, workouts and health for a given 
month. You can customize the appearance and easily navigate from one month to another. You 
can also print the view. You can double-click on any day to open in the Journal view. 

 

 
Figure 7: The Calendar view shows a monthly summary of your meals, workouts and health. 

Click here to go to the previous, 
next or current day. 

Click here to select 
a specific month. 

You can customize the 
appearance of the calendar. 

Weekly workout 
summary. 

Click on any day 
to open it in the 
Journal. 
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4.4. The Report View 
The Report view allows you to see a variety of reports about your meals, workouts and health. 
All reports can be printed. 
 

 
Figure 8: The Report view allows you to select all sorts of reports, which can be printed. 

 
Only workouts done during the period are listed. As a result, depending on the period, you may 
not see the same activities listed. 
 
The Current Reports (near the top left corner) shows the reports currently-opened. Click on an 
entry to see the associated report. Right-click on the entry to remove the report. 

You can select meals, 
workouts and health reports 
by clicking on an entry and 
choosing “Open”, or by 
double-clicking on it. 

Easily access 
reports you 
previously 
opened. 

Select 
reports of 
interest. 

Click here to select 
another period. 



VidaOne Diet & Fitness for Windows User’s Guide 14 

As an example, here is the “All Meals” report, which details all the food you consumed. 
 

 
Figure 9: The “All Meals” report. 

 
And here is a workout report (Road Cycling in this case).  
 

 
Figure 10: A workout report. 

 

Right-click an entry to edit, 
cut, copy, paste or delete the 
workout. 
 
Double-click on it to edit 
the related workout. 



VidaOne Diet & Fitness for Windows User’s Guide 15 

4.5. The Graph View 
The Graph view allows you to visualize information about meals, nutrients, workouts, health, 
body measurements, blood markers and body measurements. Graphs can be printed and 
customized (see section 10.2 for more information about how to customize them). 
 

 
Figure 11: The Graph view allows you to visualize all the information you’ve entered. 

Easily access graphs you 
previously opened. 
 
Also right-click on an entry 
to remove it from the list. 

You can 
select 
categories 
of graphs 
to show. 

You can select meals, 
workouts and health reports 
by clicking on an entry and 
choosing “Open”, or by 
double-clicking on it. 
 
You can also click “Filter 
and Open” to enter specific 
criteria about the 
information to graph. 
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The Current Graphs (near the top left corner) shows the reports currently-opened. Click on an 
entry to see the associated report. Right-click on the entry to remove the report. 
 
You can apply a filter in order to display workout that meet specific criteria, by clicking Filter 
and Open. This will show the Advanced Workout Filter (see Figure 12), which allows you to 
enter up to three conditions. 
 

 
Figure 12: The Advanced Workout Filter allows you to select only the workouts that meet specific conditions. 

 
Here are a few graph samples representing each graph category. 
 

 
 

Meals 
 
The Calorie Intake and  Expenditure represents the 
calories (or kJ) consumed (meals) vs spent (BMR + 
workouts) 
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Workouts 
 
The duration graph represents the time spent 
exercising. 

 
 

Nutrients 
 
The Total Carbs graph shows the consumption of total 
carbohydrates. 

 
 

Health 
 
The Blood Pressure shown over time. 

 
 

Body Measurements 
 
The Biceps graph shown over time. 
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Custom Fields 
 
You can also visualize all the custom fields you’ve 
entered. 

 
By default, the Pace graph uses the pace units as they were specified in the workouts. When 
opening the Pace graph, you will be prompted for the unit to use (see Figure 13).  
 

   
Figure 13: The Pace chart can be customized by activity and pace unit.  
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5. Diet 

5.1. Starting a Diet 
The first time you run VidaOne Diet & Fitness, the welcome wizard helps you set your goals, as 
described below. If you want to later review or change your goals, select Diet | Diet Goals from 
the menu and choose “I want to follow a diet and enter my goals”. VidaOne Diet & Fitness 

Entering your Profile 
Your profile is required in order to perform various calculations within MyPersonalDiet. It is 
important to enter all values to obtain the best results. The profile consists of the following and 
you can later change your profile if required via Tools | Options | My Profile: 
 

• Gender 
• Birth year 
• Height 
• Activity level 

Weight Goal 
Based on your profile, VidaOne Diet & Fitness calculates your Body Mass Index (BMI) and 
presents you with a chart showing your weight vs. various weight ranges (see Figure 14). You 
can then quickly find out and enter your target weight and as a result, set a realistic weight goal. 
 

 
Figure 14: Based on your profile, VidaOne Diet & Fitness helps you identifying your target weight. 
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Duration 
Once your profile and target weight are known, you have to choose how long your diet will take. 
VidaOne Diet & Fitness presents you a period in which you can reach your target weight 
following a healthy diet (see Figure 15). It is very important to choose a realistic duration (within 
the proposed range). Not doing so can hurt your health. For instance, it is possible to lose weight 
faster than the period shown, but this results in muscle mass losses, and other harmful effects. 
 

 
Figure 15: MyPersonalDiet presents you a period by which you  

can reach your target weight in a healthy manner. 

Diet Summary 
With your profile, target weight and diet duration entered, VidaOne Diet & Fitness summarizes 
your diet and shows you how many calories (or kilojoules) you need to lose (or gain) every day 
in order to reach your target weight. This gives you a solid daily guideline to establish your food 
and exercises habits.  
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5.2. Choosing a Diet 
Before entering data, you can choose the diet you want to follow and identify nutrients to track 
and the daily energy. From the menu choose Diet | Diet Plan. This shows the Diet window, 
composed of the Plan, Nutrients and Energy pages. 

Diet Plan 
The Plan page allows you to select one of the following predefined diets: 
 

• USDA Food Pyramid 
• High Carb 
• Low Carb 
• High Protein 
• Low Protein 
• Low Fat 

 

 
Figure 16: You can select various diet plan or create your own 

As you select them, the energetic percentage from the major nutrients (carbohydrates, proteins 
and fat) are displayed (see Error! Reference source not found., first row, left). 
 
In addition, you can choose Custom Plan and select the exact proportion of energy from these 
nutrients. 
 
Later on, as you enter food, you will be warned when food do not match these requirements (see 
section 6.1 for more details). This allows you to avoid food that may not be a good fit for your 
diet.  
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Nutrients 
You can track specific nutrients to make sure that you consume enough of them and/or do not 
consume too much of them. This is of prime important for those who have a medical condition 
that imposes some restrictions on specific nutrients. 
 

 
Figure 17: You can set minimum and maximum limits on any nutrients.  

Those limits will be used in different views, reports and graphs. 

The Nutrients page shows you a list of nutrients for which you can optionally assign a daily 
minimum and/or maximum limits. For instance, if you need to follow a diet that does not exceed 
300 mg of cholesterol per day, enter 300 under Maximum next to Cholesterol. If you need to 
consume at least 1000 mg of calcium daily, then enter 1000 under Minimum, next to Calcium. 
 
You can later chart these nutrients in the Daily and Chart views respectively for more 
information) to see where you stand with regards to the limits you chose. For instance, from the 
Day view, you can see a chart of your daily sodium consumption and be informed whether you 
can consume more of it for the day (and how much) or if you’ve exceeded the limit (and by how 
much). 
 
This gives you the ability to precisely control your diet and make sure you are following your 
own guidelines. 
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Energy 
You can set a limit of the energy you want to consume daily (e.g. 2000 calories). This is used 
when calculating the daily dietary intake (%DV). 
 

 
Figure 18: You can specify how many calories you normally consume to  

help calculate the daily dietary intake (%DV). 

5.3. Diet Results 
During a diet, click Diet | Diet Results from the menu to see an overview of your diet along the 
following aspects: 
 

1. As of Today shows where your weight is vs. your goal. You will immediately know if 
your weight is where it should be or not. 

 
2. About Eating shows how many calories (or kilojoules) you need to lose (or gain) to 

reach you goal, and how much on average you lost (or gained) since the start of your diet. 
 

3. About Exercising calculates how often you exercise and for how long, and lets you 
know if that’s enough or not.  

 
4. What To Do shows recommendations to reach your goals, based on your actual weight 

and your eating and exercising habits, such as “consider eating less, or “consider eating 
more”, etc.  
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Note: these recommendations are only that: recommendations. Use your own judgment to 
determine if they are suitable for your condition or not. You may also want to seek the help of a 

health professional to help your reach your goals. 
 
 

5.4. Food Organizer 
The Food Organizer allows you to customize the food database. It is accessible from the menu 
via Diet | Food Organizer and is shown in Figure 19: 
 

 
 

Figure 19: The Food Organizer allows you to customize the food database. 

 
You can create food items by clicking on New Food. You can copy an existing item (to 
customize it) by clicking on Copy Food. 
 
The customization performed on the food database is entirely synchronized with your Pocket PC 
if you are using MyPersonalDiet for Pocket PC. Food items created on MyPersonalDiet for 
Pocket PC are also synchronized and available on your PC. 

Filtering Food Items 
The food database contains thousands of food items, many of which you may never consume. 
Simply select the categories and food items that interest you, leaving the others unselected. 
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Importing and Exporting 
You can download and import food items from www.VidaOne.com via the Import button. 
 

Note 
Downloaded food items will be available in 2008 

 
You can also select and export a complete category into a CSV file. That file can be shared 
among friends, and it can be directly imported into the Food Organizer. 
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6. Entering Meals, Workout and Health Records 
Meals, workouts and health records can be entered from different locations: 
 

• From the menu, choose File | New. Then select among “A Meal”, “A workout” or “A 
daily health record”. 

• From the “New” button in the tool bar (a magic wand over a sheet of paper) 
• By clicking the down arrow next to the New button in the tool bar. 
• From the Journal view, by double-clicking in a blank area in the Meals, Workouts or 

Health panels. 

6.1. Entering Meals 
The Meal window is shown in Figure 20. 
 

  
Figure 20: The Meal window allows you to enter food items and extra servings for a meal. 

Use this button 
to clear  all 
listed entries. 

You can enter a 
note about the 
meal. 

Enter extra 
servings here. 
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Entering Food Items 
You can add, edit or delete food items from the meal using the Add, Edit and Delete buttons 
respectively (more on this later). 
 
Tip! You can also tap the down arrow  next to the Add button to add one serving of the 
following: 
 

1. A food item from your favorite food item list 
 

2. A food item you search for. 
 
Depending on the time of the day, a type of meal will automatically be selected among 
Breakfast, Lunch, Dinner, Snack/Drink, Supplement and Other. This is for informational 
purposes only; you can change it if need be. 
 
You will later see how food items can be combined in meals. The Meal list is initially empty the 
first time you use VidaOne Diet & Fitness, but once meals are created, you can select them next 
to Meal and their food items will be added to the list. 
 
When you choose Add from the Meal window, the Food Browser is shown (see Error! 
Reference source not found.). This is the main window by which you enter the food you 
consume. 
 
To enter a food item, select a food group and a category and then choose a food item. Upon  
choosing an item, the Food Information section (the lower part of the screen) will be updated 
with useful information. You can use this information to find out exactly what you are 
consuming. Go ahead, and browse the whole database to learn about what you are really eating! 
You’ll be surprised! 
 
Then choose the amount (or quantity) you consumed. In most cases, it is preferable to choose “1 
serving” (i.e. one default serving), which corresponds to one usual serving of the related food 
item. The calories (or kilojoules) field, along the nutrients data, are updated to reflect the amount 
you are consuming. This information allows you to precisely decide whether you should eat the 
whole portion you had in mind (or perhaps only half of it). 
 
Once done, tap the Add to Meal button to add the food in the meal.  
 
Food items that you add are also stored in the Favorites list (more about this shortly). 
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Figure 21: The Food Browser window allows you to browse the entire food database and  

enter the amount you consumed of the selected food item. 

 

Messages like this 
are shown for 
food items that do 
not match your 
diet plan. In this 
example, this 
food is not 
appropriate for a 
“low carb” diet.

See nutrients by 
weight or %

Drag the corner 
of the window 
to resize it. 
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Favorite Food Items 
Whenever you add a food item into a meal, that food item it added to the favorites list. The 
favorites food item list is accessible by tapping the Favorites button  in the Food Browser. 
This shows the most recent favorite food items; tap on one to select it. Using the Favorites button 
is a quick way for selecting food items you frequently consume. 
 
The list items contains a limit of items that can be added. The purpose of this limit is to discard 
food items you rarely consume. You can “pin” an item (tap-and-hold the item and select Pin to 
make sure the item is not automatically removed from the list as new items are added. To 
“unpin” an item, tap-and-hold the pinned item and select Unpin. 
 
When you select a food item, it is added to the meal using an amount of “1 serving”. If you 
prefer to be prompted every time you select the item, tap-and-hold the item and uncheck Use 1 
serving. 
 

  
Figure 22:The Favorite Food Items window lists all your favorite food, grouped by categories. 

Click this button 
to control how 
many items can 
be held in the list. 

Right-click an 
item to remove it 
from the list. 

Drag the corner 
of the window 
to resize it. 
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Searching Food Items 
You can search the food database by tapping the Search button . This shows the Search 
window (see Figure 23). Enter a word (or part of a word) and tap Search to show the matching 
food items from the food database and from your own food. 
 

 
Figure 23:The Search Food window allows you to search the food database for a specific keyword. 

Searching by one word can return too many items (223 in the previous example) To perform a 
more effective search, enter several words, and only items containing all words will be shown. 
What’s more, prefix a word with an hyphen (–) to exclude food items that contain that word.  In 
Figure 24, the search returned entries that contains both milk and lowfat, but not cheese (bringing 
the number of entries down to a more manageable eight). 
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Figure 24:An enhanced search returns fewer and more accurate results. 

Combining Food Items Into Meals 
You can save one or more food items as a meal, and use that meal later on to expedite data entry. 
Figure 20 shows the New Meal window with two food items. Choose the Meals button, select 
New Meal and enter the meal’s name, serving size and the amount of servings it contains (see 
Figure 25), in order to save the food items under that meal.  
 

 
Figure 25: When creating a you can also choose to add one serving when recalling that meal  

(or instead being prompted for the amount to use). 

 

Drag the corner 
of the window 
to resize it. 
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To use that meal at some other time, select its name from the meal list, choose the Meal button 
and select Add Meal. A single serving of that meal will be added, unless the option “always use 
1 serving when adding this meal” was selected when adding/editing that meal; in that case, you 
will be prompted for the exact amount to use. 
 
You can update the content of a meal with the food items currently listed. Simply choose the 
Meals button  and select Update Meal. If you want to delete the meal, choosing Delete Meal 
instead. Deleting a meal does not remove the food items currently listed. To rename the meal, 
choose Edit Name. 

Enter Your Own Food Items 
You can add your own food items by clicking on New Food button in the Food Browser. This 
shows the Custom Food Item window (Figure 26). Enter the name, the default serving (e.g. 100 
g, 1 cup, etc.), the calories (or kJ) for that serving, the food group this food item belongs, the 
nutrients and a note if desired.  
 
Choose the Calculator  button to calculate the energy based on the nutrients you’ve entered. 
The calculation is based on 4 calories per gram of Total Carbs and Protein, and 9 calories per 
gram of Total Fat. 
 

 
Figure 26:The New Food Item window allows you to enter you own food items. 

You can choose to enter the 
nutrients by weight (g or mg), or 
by percent daily value (%DV). 

Tap this button to calculate the 
calories based on the carbs, 
protein and fat nutrients. 

Nutrients are listed 
in the same order 
than you find on 
US food labels. 
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Enter Additional Servings 
When entering a meal (see Figure 20), you can enter additional information for the meal. 
 

• Amount of water servings you consumed (one serving is 1 cup or 250 ml), a quicker 
alternative to enter water via the Food Browser. 
 

• Extra calories (or kJ) for the meal. If all you want is to track is the energetic value of 
a meal and you know what it is, you can simply enter it there, without providing 
additional information. Note that the nutrients will remain zero for this meal. 

 
• Additional servings for the meal. This is useful when you eat a meal composed of a 

variety of food items: instead of entering each of them individually, you can estimate 
how many servings of each food group the meal is composed of, and only enter the 
servings. MyPersonalDiet uses average energetic values per food group serving, as 
displayed in following table (values are rounded for simplicity) 

 
Food group Total cal. Cal. from carbs Cal. from prot. Cal from fats 
Starch (grains) 90 68 8 14 
Protein 179 29 56 94 
Fruit 98 90 3 5 
Vegetables 69 52 8 9 
Dairy 102 16 27 59 
Fats, oils, etc. 108 31 4 73 

Table 1: Energetic values per food group (per serving). 

 

6.2. Entering Workouts 
 

Note 
 

If you are using a Polar heart rate monitor, refer to section 7 on page 51. 

Adding a Workout 
To create a workout, select New from the File menu. The New window (see Figure 27) is shown: 
 

• If desired, click A workout. 
 
• Check Apply activity filter to display only the activities you have filtered (see section 

9.2 for information on filtering activities).  
 

• Choose an activity among those listed. You can add an activity by clicking the  
button. See the Entering Strength Training section on page 43 for more details.  

 



VidaOne Diet & Fitness for Windows User’s Guide 34 

• You can also edit or delete the selected activity – provided it is an activity you previously 
created – by choosing the  and  buttons respectively.  

 
• Click OK 

 
Next, a workout data entry window is shown for the selected activity. There are two types of 
workout data entry windows: cardio (Figure 28) and strength (Figure 29). There are only a few 
differences, which are described in the following sections. 
 

  
Figure 27: Adding a workout. 

 

You can add, edit or delete a 
custom activity by clicking 
this button.

Activities you recently chose 
are shown first (using a pale 
blue background). 

Check this box  to display 
only the activities of interest 
to you. See section 9.2 for 
details of the activity filter. 
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Figure 28: The workout data entry windows for cardio workouts. 
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Figure 29: The workout data entry windows for strength workouts. 
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You can enter as much information as you want (the more the better), but you can leave any field 
blank as well. 
 

General information: 
 

• Enter the workout duration. Format is either hour/minute/second or hour/minute, 
depending on the workout duration setting (see section 10.4 for information on the 
workout duration setting). Note that the Calories and Fat fields are automatically 
updated based on the duration you enter and your weight. You can change those 
values by clicking on them; you will be prompted for a new value. Should you modify 
them, they will no longer be updated when the duration or exertion is changed, unless 
you reset them to 0. 

 
• Enter your perceived energy, exertion, your overall rating of your workout, and a note 

about this workout (weather, etc.) Note that changing the perceived exertion may 
change the Calories and Fat fields, as it does for the duration. 

 
General information for cardio workouts only: 
 
• Enter the location information:  course, distance, pace and ascent (elevation). To browse, 

add, or delete courses, click the  button (see section 6.4 regarding browsing). Note 
that upon choosing a course, the distance and pace will reflect the course’s default 
distance and pace. 
 

• If the record was recorded using VidaOne GPS on your mobile device and later 
synchronized, you can view the course by clicking on the GPS          button. You can 
choose to see the route as follows: 
 

o Using VidaOne GPS route viewer. 
o Using Google Maps (requires an active Internet connection) 
o Using MapMyRide.com (requires an active Internet connection). 

 
If the workout does not have a route associated with it, you can import a GPB files. GPB 
files are generated by VidaOne GPS. 

 
• Enter weather information 

 
General information for strength training workouts only: 

 
• Enter the location at which the training took place. To browse, add, or delete locations, 

click the  button (see section 6.4 for information regarding browsing). 
 

• Enter the warm-up and cool-down period. 
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Detailed information: 
 
• Enter the average training heart rate, the target zone, and the percentage of time spent in 

the target zone.  
 

• Click the Training Zones button to edit your training zones (more in section 9.4) 
 

• Click the Calculator button to calculate the percentage (see Figure 30). 
 

 
Figure 30: The Percentage Calculator window. 

 
• Enter up to four custom fields (see details in the next section). 

 
Detailed information for cardio workouts only: 

 
• Enter lap or interval training data (see the Entering Cardio Training Intervals section 

below for more information about intervals). 
 

Detailed information for strength workouts only: 
 

• Enter the exercise data (see the Entering Strength Training Exercises section on page 43 
for more information about exercises). 

Tracking Your Own Data with Custom Fields 
One of the most powerful features of VidaOne Diet & Fitness is its ability to track the data of 
your choice for activity and health records. This is very useful for entering specific information 
about your workouts or your health that is not listed by default. Here are a few examples: 
 

• The equipment you use, such as the shoes you use for your running workouts, the 
bicycles you use for your road cycling or mountain biking workouts, or the videotape you 
watched while exercising. 

 
• In a competition, your position/rank in the final classification. 

 
• Any food supplement you took prior to, during, or following the workout. 
 
• Health information such as glucose or cholesterol, for example. 
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All in all, you can enter any information you want to track, whether it is a number or a value 
from a selection list (that you define!) In addition, each custom field is listed in the Graph view, 
so that you can see a chart of the values you entered. 
 

To add a custom field, click the Browse Custom Field  button next to the <…> fields, from 
either a workout window (Figure 28) or the Health window (Figure 38), and choose Add Field. 
The Add Custom Field window (Figure 31) will be displayed, and will allow you to enter the 
following information: 
 

• The name of the field (which you can change later). 
 
• The type of value to track, either a number or a selection. 

 
o Number: you can enter a positive number (e.g. 1, 1.5, 1.52, etc.) Check Do not 

display if 0 if a value of 0 should not appear in a graph. 
 

o Selection: use the buttons next to the list to add values from which to choose. You 
can revisit this list at a later time and add other values. However, the order is very 
important and it is not recommended that you remove values already listed, even 
if you don’t plan to use them anymore. 
 

Note 
 

Once the list is defined, do not delete or alter the order of the values already 
entered. Otherwise, the values entered in previous workouts may be displayed 
incorrectly. 

 
• Since the custom field will be included in the graph view, enter the type of graph to show 

and the color to use. You can see a sample of the graph as you set these parameters.  
 
Once a custom field has been added, it will be added to the menu displayed after clicking the 
Browse Custom Field button, as shown below: 
 

 
 

The list of available custom 
fields you have previously 
created is automatically 
shown. Click on any field to 
select it. 

This selection allows you to 
‘erase’ the custom field 
being used in the workout or 
health record. 

You can add a custom field 
as well as edit or delete the 
current custom field by 
using these options. 
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When entering a workout (or health record), simply select a listed custom field in order to use it, 
and enter the appropriate value. If the custom field is a number, simply enter the appropriate 
value; if the custom field is a selection field, simply choose the appropriate value from the list. 
 
To clear the custom field, select Clear Field. For instance, if you chose the Bike custom field 
and decide that you don’t want to enter a Bike value, you may choose not to enter any value, or 
you may click Clear Field to unselect the custom field altogether. 
 
You can later edit a custom field by choosing Edit from the menu. You can also remove a 
custom field by choosing Delete. Note that this removes the custom field definition. As a result, 
it can no longer be selected in workouts or health records. 
 

  
Figure 31: The Custom Field window. 

This shows an example 
of what the graph will 
look like based on the 
graph type and color 
you choose. 
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Creating Your Own Activities 
VidaOne Diet & Fitness comes with pre-defined activities, such as Road Cycling, Running, etc. 
You can easily add unlisted activities, or even create specialized activities, such as ‘Time Trial’ 
(a specific road cycling type of training). To add an activity, click the Add button (refer to 
Figure 27) to add an activity. The New/Edit Activity window will be shown (Figure 32): 
 

• Enter the name of the activity. 
 

• Choose the type of activity (either cardio-vascular or strength). 
 

• Choose an icon by clicking one of the displayed icons. You can change the color of the 
icon by clicking the “Color” button. 
 

• Choose how to calculate calorie expenditure (i.e., the amount of calories you burn while 
performing this activity): 
 

o Choose Use default calculation to approximate the calorie expenditure based on 
your gender, the type of activity (cardio or strength), the duration, and the 
intensity of the workout. 
 

o If you know how many calories you burn for a given workout of that type (if you 
use a treadmill or other equipment that calculates the number of calories), simply 
enter how many calories you burn for a given period of time at a specific 
intensity. When you later create workouts for that activity, the calorie expenditure 
will be calculated by VidaOne Diet & Fitness using these parameters. 

 

  
Figure 32: The New Activity window. 

VidaOne Diet 
& Fitness can 
precisely 
calculate how 
many calories 
you burn for 
subsequent 
workouts if you 
enter these 
values. 
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Entering Cardio Training Intervals 
You can enter interval training data for your cardio workouts: 
 

• Select a cardio workout (see Figure 28). 
 
• In the interval list, choose Add. The interval data entry window will be shown (see Figure 

33). 
 

 
Figure 33: The Interval data entry window. 

• Select an interval. To update intervals, choose the Add, Edit or Delete buttons (see 
section 6.4 for information regarding browsing). 

 
• Enter the number of sets. 

 
• Enter the duration for each set, using the format shown next to the field name (the exact 

format depends on your regional settings). If the duration varies from one set to another, 
use the Notes field to enter more information if desired.  

 
• Enter the recovery period following each interval, using the format shown next to the 

field. If the recovery varies from one set to another, use the Notes field to enter more 
information if desired.  

 
• Enter a note if desired. 

 
• Click OK to close the window.  
 

When adding a new cardio workout, an option allows you to carry over the previous interval data 
for the same activity (see section 10.4 for more details). 
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Entering Strength Training Exercises 
You can enter individual exercises for your strength workouts: 
 

• Select a strength workout.  
 

• In the exercise list, choose Add. The exercise data entry window will be shown (see 
Figure 34). 

 

 
Figure 34: The Exercise data entry window. Predefined exercises are shown with pictures. 

 
• Select an exercise. To update the exercise list, choose the Add, Edit or Delete button (see 

section 6.4 for more information about browsing exercises). Upon choosing an exercise, 
the Unit field will reflect the exercise’s default unit. 
 
You can also select an exercise by clicking on the Muscle Chart button, which shows the 
muscle chart (see Figure 35). Muscle groups are displayed using different colors. Simply 
move the mouse over a muscle group to see its name (which will be displayed in a small 
popup window). Right-click on a muscle group and a menu of related exercises will be 
displayed. Click on one of those exercises to select it. 
 
Exercises that you created will also be displayed provided you specified the muscle 
groups being worked on (see section 6.4 for details). 
 
 

 



VidaOne Diet & Fitness for Windows User’s Guide 44 

 
Figure 35: The Exercise data entry window. The muscle chart allows you to select exercises  

that are relevant to specific muscle groups. In this figure, the user right-clicked on the abdomen muscle 
group, which shows three (3) suitable exercises. 

• To see the most recent occurrences of the exercise, click on the Chart button. 
 

• Enter the number of sets. The number of sets is limited to five. If you do more sets, add 
the exercise again in the exercise list. 

 
• Select Show each set if you want to enter the repetition and weight for each individual 

set. This is useful if, for instance, you use reduced sets, where the first set is a little lighter 
(to warm up) than the remaining sets. Don’t select this option if you use the same 
repetition and weight for each set. 

 
• Enter the number of repetitions and the weight. If those numbers vary from one set to 

another, select Show each set, as explained above.  
 

• Enter the unit. Remember to use the same unit when entering other instances of the 
exercise. If the weight varies from one set to another, use the Notes field to enter more 
information if desired.  

 
• Enter an optional note if needed. 

 
• Choose OK to close the window.  

 
When adding a new strength workout, an option allows you to carry over a previous similar 
workout's exercises (see section 10.4 for information about workout options). 
 



VidaOne Diet & Fitness for Windows User’s Guide 45 

Editing a Workout  
To edit a workout, first display the related activity window (see section 4.3 for details about 
activity views). Then locate the workout, right-click on it and select Edit Workout, or simply 
double-click on the entry. Directly modify any values you want to change, as you would when 
entering workout data. 

Copying and Pasting a Workout 
You can cut or copy and paste any workout. For instance, you can copy a past workout in order 
to add a similar workout, or you can cut and paste a workout to move it from one date to another. 
 

• Select the workout in the Calendar. 
• Right-click the entry. A menu will appear, consisting of Cut, Copy, Paste, and Delete. 
• Choose Copy. A copy of the workout will be internally created. 
• Then right-click anywhere on the view to display the same menu again. 
• Choose Paste. This will show the Paste To window (see Figure 36). 
• Select a date and click OK. This creates a new workout based on the past workout (i.e., a 

copy). If you paste a workout not related to the activity being shown (for instance, 
pasting a running workout in the road cycling activity view), you will be prompted to 
open the appropriate view (the running activity view in this case). 

 

 
Figure 36: The Paste To window lets you choose a date to paste clipboard information to. 
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Deleting a Workout  
Deleting a workout permanently erases the workout data. 
 

• Select the workout. 
 
• Right-click the entry. A menu will appear, consisting of Cut, Copy, Paste, and Delete. 

 
• Click Delete. You will be prompted to confirm the deletion. 

 
• Click Yes to permanently delete the workout, or No to cancel and keep the workout.  

More About Intervals and Exercises 
Right-clicking an interval or exercise shows the following menu, and allows you to: 
 

 

• Edit the interval/exercise. You can also double-click the interval/exercise 
to edit it. 

• Chart up to the last 10 most recent entries (see Charting Intervals and 
Exercises below for more information). 

• Scratch the interval/exercise to display it with a scratch bar on it. This is 
useful if, for a given workout, you did not complete a specific exercise, yet 
you want to keep it in the exercise list. 

• Cut the interval/exercise (for a subsequent paste operation). 
• Copy the interval/exercise (for a subsequent paste operation) 
• Paste an interval/exercise (provided that one has previously been cut or 

copied). 
• Move the interval/exercise up in the list. 
• Move the interval/exercise down in the list. 

Charting Intervals and Exercises 
Interval and exercise charts show up to the last 10 occurrences and allow you to see your 
progression (see Figure 37). Note that those charts are not accessible from the Graph view. 
 
To see such a chart, right-click on an interval or an exercise, and click Chart: 
 

• Intervals are shown with the duration time in red and the recovery time in blue. Actual 
duration is either the total duration (set * time) or the duration itself, depending on your 
Display option setting (see section 8.2 for Display options). 

 
• Exercises are shown using either the weight itself or the total weight (set * rep * weight) 

(see section 8.2 for information about Display options). Note that weight-less exercises 
(e.g., crunches) can only be charted when the total weight option is selected. 
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Figure 37: A workout chart depicting the most recent entries for an exercise. 
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6.3. Entering Health Data  
To enter Health data, select New from the File menu (this shows the New window – see Figure 
27), click Daily health record, and then OK. This shows the Health Record data entry window 
(see Figure 38). 
 

  
Figure 38: The Health Record data entry window. 

 
You can enter information about:  
 

• Your weight. An option allows you to use either American or Metric units (see section 
8.1 for details). You can see a chart of your body weight (see section 4.5 for details). 

 
• Your body fat, percentage. The use of a fat caliper makes it easy to obtain this number. 

 
• Your resting heart rate. Note that it is best to check this when you wake up (i.e., at rest). 
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• Your blood pressure. You can take it at any time of the day, although it is preferable to 
take at about the same time from one day to another (e.g., when you wake up, when 
going to bed at night, etc.) 

 
• Your activity level for the day. This allows better calculating your BMR and is 

recommend to enter when on a diet, 
 

• Your mood for that day. 
 

• Up to four (4) custom fields. See page 38 for details. 
 
• Sleep quality and duration 

 
• A note. 

 
• Body measurements and blood markers (which can be charted in the Graph view) 

 
It is best to enter this information a few days per week to provide accurate graphs. At a 
minimum, you should enter your resting heart rate and weight on a weekly basis, in order to 
review your performance over time. 
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6.4. Browsing Intervals, Exercises, Courses, and Locations 
You can browse, add, or delete intervals and exercises when prompted to enter one. For instance, 
Figure 34 on page 43 shows the Exercise window where you can add, edit/view, or delete 
exercises.  
 
When adding a workout, you can add, edit/view, or delete a courses or location by clicking on 

the Update button  and choosing among Add, Edit or Delete.  
 
When adding exercises, you can specify the muscle groups being worked on by either checking 
their name off, or clicking on them in the muscle chart. Later on, when entering exercises (see 
section Entering Strength Training Exercises on page 43), your own exercises will be listed if 
you use the muscle chart to select an exercise. 
 

 
Figure 39: The Add Exercise window. You can specify which muscle groups are being worked on. Later on, 

when adding exercises for a workout, your own exercises will be listed if you use the muscle chart. 
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7. Using a Heart Rate Monitor 
If you own a Polar model AXN, F, CS, RS, or A-series heart rate monitor, you can directly 
download the exercise file(s) – the workouts stored in the monitor – into VidaOne Diet & fitness. 
You can also import HRM files that are not already associated with a workout. 

7.1. Downloading Exercises from Heart Rate Monitors (HRM) 
To download a workout, choose Fitness | Polar Heart Rate Monitor | Download HRM 
Exercises Files, or click the HR File button in the menu bar. The Heart Rate Monitor wizard 
will be shown (see Figure 40) and will guide you step by step through downloading the data 
from your heart rate monitor. The exact procedure depends on the monitor (the steps are self 
explanatory), but common features are the following: 
 

• You can create a new workout based on the heart rate data; 
 

• You can replace an existing workout in VidaOne Diet & Fitness by the data from the 
heart rate monitor; 

 
• You can merge two or more exercise data files (from your heart rate monitor) into one 

workout in VidaOne Diet & Fitness. This is particularly useful if you briefly interrupted 
your workout, resulting in two exercise data files in your heart rate monitor. See section 
7.4 for details.  

 

 
Figure 40: The Heart Rate Monitor download wizard guides you step by step through downloading your 

workout data right into VidaOne Diet & Fitness. 

 
Upon downloading a workout from your heart rate monitor, the data is saved into an .HRM file.  
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Note 
 

HRM files downloaded by VidaOne Diet & Fitness are located in the “My 
Documents\VidaOne\profile\year” folder  

(e.g., My Documents\VidaOne\Josh\2002).  
You can change the directory via the Options (see section 10.5). 

 
Once the data is downloaded, the workout entry window will show two additional buttons: the 
HRM View button, which starts the HRM Viewer (described in the next section) and the HRM 
Email button, which creates an email with the HRM file attached to it. This is a very handy 
feature if you want to quickly send your HRM data to your coach or friends. 
 
 

 
 

7.2. Viewing HRM Files 
Heart rate monitor data files (HRM files) are shown via the VidaOne Polar (see Figure 41). 
There are three ways to view HRM files: 
 

1. In VidaOne Diet & Fitness, click the HRM View button while looking at a workout. This 
will show the related HRM file. 

 
2. From the Windows File Explorer, double-click any HRM file (or right-click and choose 

Open). 
 

3. When the VidaOne Polar is running, you can also drag HRM files from the Windows 
File Explorer directly onto the HRM Viewer to open them. 

 
The HRM Viewer allows you to see multiple HRM files at once. You can resize each file as you 
see fit, or you can automatically arrange the layout via the Windows menu to cascade or tile the 
files. 
 
The exact information that is displayed depends on your heart rate monitor model and available 
options. For instance, the Power, Power Index and Power L-R values are available with the 
Polar® S710 equipped with the Power Output Sensor™. 
 
The HRM Viewer displays a chart with several lines, each of them corresponding to one of the 
following parameters: heart rate, speed, cadence, altitude, power, power index and power left-
right balance (power L-R). Parameters are only listed if they were recorded during the workout. 

Click to email the 
workout data file. 

Click to view the 
workout data. 
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Each parameter is summarized below the chart: it is displayed with the minimum, maximum, and 
average values. The checkbox next to each parameter allows you to show/hide the associated line 
on the chart (if you want to clearly display only one parameter, for example). 
 
You can click-and-hold anywhere on the chart and the values at that point will be displayed 
below for each parameter, allowing you to identify specific values on a chart (such as a high 
altitude point). 
 

  
Figure 41: The HRM Viewer allows you to see one or more heart rate monitor workout data. 

 

Click anywhere 
on the chart and 
the values at that 
point will be 
displayed below 

These options 
allow you to 
customize the 
display. 

Click 
here to 
see lap 
data 
when 
present. 

You can hide specific lines 
by un-checking them 
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When viewing an HRM data file, the HRM Viewer allows you to do the following (the images 
on the left are the corresponding toolbar buttons): 
 

• Print the chart (File | Print). 
 

• Email the HRM file to a friend or coach (Tools | Send to Mail Recipient). This feature 
uses your standard email settings. 

 
• Export the HRM file to a .CSV file, which can be viewed by Microsoft® Excel  

(Tools | Export to CSV File). 
 

• Zoom in and out to see workout details. 
 

• See lap information (if available). Click Tools | Show Laps to display lap information, as 
shown in the figure below. To remove that window, click Tools | Show Laps again. 

 

 
Figure 42: The HRM Viewer can show lap information when available. 

 
• Get data about a specific period of time (snapshot). Click Tools | Select Snapshot to 

enter in the snapshot mode. In that mode, the cursor appears as a cross when positioned 
over the graph and a snapshot window is will be shown (see Figure 43). Press and hold 
the mouse’s left button and drag the mouse to select a period of time. The data for that 
period is displayed in the Snapshot window. To remove the window and exit the snapshot 
mode, click Tools | Select Snapshot once more. 

 

 
Figure 43: That snapshot mode allows you to select a portion of your workout and gets statistics about it. 
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• Display the time spent in each zone (Figure 44). Click Tools | Time in Zones to display a 
window that shows the time spent in each training zone. Click  Tools | Time in Zones 
again to remove the window. 

 

 
Figure 44: The HRM Viewer can show the time spent in each training zone. 

 
You can also customize the appearance of the chart as follows: 
 

• Check Corrected values to automatically adjust some data and enhance the charts. 
Specifically, the following values are corrected: 

 
o Heart rate samples that fall below 30 or above your maximum heart rate are 

ignored. Heart rate monitors are very sensitive to electromagnetic signals and may 
store incorrect values from time to time. 

 
o Speed samples that are zero (when you were stopped) are discarded. 
 
o Cadence, power, and power index samples that are zero (when you had stopped 

pedaling) are discarded. 
 

• Check Show lap markers to display laps (shown as purple vertical bars). The option is 
disabled if there is no lap information available. 

 
• Select a different background from among the following choices: 

 
o No background, which displays a white background. 
 
o Lines, which displays horizontal lines matching the markers on the Y-axis. 

 
o HR Zones, which paints your heart rate zones, as calculated in VidaOne Diet & 

Fitness (see section 9.4). This option allows you to quickly see the intensity of 
your workout. 

 
• Click Settings to change general display options, such as setting a different speed or 

altitude scale, using different line colors, or using thicker lines. 
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7.3. Importing Existing HRM Exercise Files 
If you previously downloaded exercise files from your heart rate monitor into HRM data files, 
choose Fitness | Polar Heart Rate Monitor | Import HRM Exercise Files and choose a file. A 
workout will be shown, as if you had downloaded the data from your heart rate monitor. Modify 
the workout values if need be, and click OK to create the workout, or click Cancel to abort. 
 
As with a download, VidaOne Diet & Fitness will prompt you if there’s already a workout that 
took place on the same date and time. If so, you are presented with four options: 
 

1. Replace the workout with the new one. 
 
2. Update the existing workout with the HRM data (the distance, pace, and heart rate data 

fields are updated). 
 

3. Attach the HRM data file to the workout, but leave the workout information intact. 
 

4. Cancel the operation (and leave the existing workout intact). 
 
Select the option that best suits your needs. 
 
You can also select multiple files when prompted for a file, by clicking on each file while 
pressing the Ctrl key. VidaOne Diet & Fitness will then asks you if you want to use the same 
activity (or not) for each workout, and whether you want to edit each workout before importing 
them. IF you are importing various files that are related to the same activity (e.g. “Road 
Cycling”) and you just want to import them “as is”, these options allow you to import them all at 
once automatically. 

7.4. Converting HRB Files to HRM Files 
If you are using VidaOne Polar for Pocket PC, Polar workouts are downloaded as HRB files on 
your Pocket PC, and synchronized with your PC (see Appendix A for details). These HRB files 
contain a proprietary format and can be viewed with VidaOne Diet & Fitness HRM (see section 
7.1).  
 
To convert these HRB files to standard Polar® HRM files (which can be viewed with polar 
Precision Software), choose Fitness | Heart Rate Monitor | Import HRM Exercise Files, and 
select one or several HRB files. Then specify an output folder, and choose Convert. The original 
HRB files themselves will be left intact, and the corresponding HRM files will be created. 
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7.5. Merging HRM Data 
VidaOne Diet & Fitness has a unique helpful feature: merging of HRM data. Imagine the 
following scenario: during a bicycling workout, you take a 10-minute break at a convenience 
store to fill yourself up with cold liquids. By the time you’re back to your bike, your heart rate 
monitor, which sits on your bicycle handle bar, has shut down the current exercise. You have no 
choice but to start a second exercise. But what you really want is to get the data for the whole 
workout. 
 
VidaOne Diet & Fitness allows you to reconstruct the original workout from two exercise data 
files and obtain the summary data for the whole workout as if it had not been interrupted. 
Whether you download data from your heart rate monitor or import HRM files, VidaOne Diet & 
Fitness verifies your workouts beforehand, and notifies you if there is a workout – called a back-
to-back workout – that either ended up within one hour or started within one hour of the current 
workout. If this is the case, you can merge the workout with the back-to-back workout, resulting 
in one single workout that combines both. In the scenario presented above, you can merge the 
two workouts into one, and view all the data as if the workout had not been interrupted. 
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7.6. Updating General Settings for S-Series Monitors 
You can update various settings stored in the heart rate monitor via VidaOne Diet & Fitness. To 
do so, select Fitness | Polar Heart Rate Monitor | Update General Settings. You will then be 
prompted to select the mode of your heart rate monitor, and to establish a connection. Once the 
connection is established, the General Settings window is shown (see Figure 45). There are 
various categories to choose from: 
 

• User: gender, weight, height.  
• Watch: date and time. 
• Reminders: up to seven (7) reminders can be programmed. 
• Monitor: monitor settings (specific functions). 
• Bicycles: up to two (2) bicycle settings can be entered. 

 
Note that all these parameters are specific to the heart rate monitor and are independent of the 
settings stored in VidaOne Diet & Fitness. 
 

 
Figure 45: The Watch page in the General Settings window. 

Select a category and the 
related fields will be shown 
on the right side. 
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7.7. Updating Exercise Settings for S-Series Monitors 
You can program up to five exercise settings in your heart rate monitor. From the Fitness menu, 
select Polar Heart Rate Monitor | Update Exercise Settings. After selecting your heart rate 
monitor model and connecting, the exercise list will be shown (see Figure 46). There are two 
types of exercises: continuous  and intervals , described in the following paragraphs. 
 

 
Figure 46: The Exercise List window shows the five exercises stored in the monitor. 

 
Continuous exercises are based on up to three timers, which automatically repeat (1-2-3-1-2-3-
etc.) until you stop the workout. You can associate heart rate limits with each timer. For instance, 
Figure 47 shows continuous training using two timers. In this case, the first timer is used as a 15-
minute warm-up. The HRM will beep when the heart rate falls below 132 or goes above 152. 
The warm-up is then followed by a 90-minute work period, during which the HRM will beep 
when the heart rate falls below 152 or goes above 172. Following the workout, the third timer 
kicks in, which has been set for a 15-minute cool-down period (no alarm will beep based on the 
measured heart rate). An optional recovery phase can be set in addition to these periods. This 
type of exercise is ideally suited for working on your aerobic system. 
 

Double-click an exercise to 
edit it. 
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Figure 47: Continuous training window. 

 
Interval-based exercise consists of 1 or more sets of high-intensity efforts followed by short 
periods of active recovery (rest). This type of exercise is designed to improve your high-end 
endurance. In addition to these sets, interval-based exercises include a warm-up and cool-down 
phases, which can be based on duration, heart rate, or distance (for S710 models only). 
 
Whichever type you choose to define, simply follow the various screens that gather all the 
information required for the exercise. For more details about the exercises and various options, 
refer to your heart rate user’s manual. 

Click this button to quickly 
set the HR limits based on 
your training zones.
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8. Viewing GPS Data 
People using VidaOne GPS1 on their Pocket PC can see their routes when looking at a workout 
containing GPS data, by clicking on the GPS button and choosing View (see Figure 48). When 
viewing a GPS data file, you can zoom in & out, and print the map (useful to distribute to your 
friends when going for an outdoor workout such as hiking or cycling. At the moment, only GPS 
data from MySportTraining for Pocket PC can be viewed. 
 
You can also choose Import to read a GPB file (also from VidaOne GPS for Pocket PC) and 
associate it with the current workout. 
 

 
 

 
Figure 48: You can view the GPS data collected via VidaOne GPS for Pocket PC 

                                                 
1 Available at http://www.vidaone.com. 

Click this button to see GPS 
data collected with  
VidaOne GPS  
(for Pocket PC only). 
 
You can also choose to view 
the route on Google Maps or 
MapMyRide.com 
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9. Other Features 

9.1. Choosing a Period 
Report and Graph views are based on a period, which you can change by clicking on it. This will 
display the Period window (see Figure 49), allowing you to choose another period. There are 
several pre-defined periods to choose from, and you can also specify a period by clicking 
Custom period and selecting the start and ending dates. 
 

 
Figure 49: The Period window allows you to choose any period. 
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9.2. Find 
You can search the notes of both workouts and health records for a word via Edit > Find (or 
Ctrl+F). For instance, Figure 50 shows the result of finding the word “flat”. You can then click 
on an entry to edit it. 
 

 
Figure 50: The Find window. 
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9.3. Activity Organizer 
You can filter activities to show only the activities that are of interest to you, resulting in 
improved clarity. For instance, when adding a workout (as described in the Adding a Workout 
section on page 33), only filtered activities will be shown. 
 
To access the Activity Organizer: 
 

• Choose Activity Organizer from the Fitness menu.  The Activity Organizer window is 
displayed (see Figure 51 on page 65). 

• Use the Add, Edit and Delete button to manage custom activities. 
• Check activities to be displayed and uncheck activities to be filtered out (hidden). You 

can also use the following buttons: 
o Click All to select all the activities 
o Click Clean to un-select all activities 
o Click My Activities to select the custom activities only. 

 
Note 

 
Filtered activities are not displayed in the views.  

They will be shown only when you check them off again. 
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Figure 51: The Activity Organizer window. 
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9.4. Training Zones  
Training zones are essential for heart rate monitoring-based training. VidaOne Diet & Fitness 
automatically calculates your training zones, a feature that is very useful if you use a heart rate 
monitor. 
 

 
Figure 52: The Training Zones window with the effort coloring option on (left) and off (right). 

 
To calculate your training zones: 
 

• Choose Training Zones from the Fitness menu to show the Training Zones window (see 
Figure 52). Colors are used if the effort coloring option is on (see section 10.1 for display 
options). 

 
• Enter your maximum heart rate (if you have measured it). The default is set to 220 minus 

your age2, provided you entered your birth year in the profile. Note that this formula is 
just an estimate, and your actual maximum heart rate may vary by as much as + or - 20. 
This value is dictated by your genes, not your fitness. 

 
• The training zones are automatically calculated and each training zone is defined as a 

range expressed as a percentage (%) of your maximum heart rate (HR). The exact 
calculation is as follows: 

                                                 
2 This is the official formula adopted by the American College of Sports Medicine (www.acsm.org). 
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Zone Minimum Maximum Intensity Description 

5 92 100 Exhausting Anaerobic 
4 85 91 Strenuous Lactate threshold training 
3 75 84 Sustained Aerobic 
2 65 74 Moderate Endurance 
1 55 64 Effortless Recovery 

Table 2: Default training zones. 

 
• You can choose to see either the training zone percentages, or the corresponding heart 

rate beats, calculated on your maximum heart rate. 
 
• If your heart rate monitor only allows you to enter your target zone's minimum and 

maximum as multiples of 5, check off the Use 5-beat increments option to round up 
values as multiples of 5. 

 
• Click the Customize button if you prefer to specify your own training zones. You can 

choose the number of training zones (1 to 10), how they are calculated and specify the 
details for each zone (see Figure 53). 

 

 
Figure 53: You can customize the training zones to fit your workouts. 

 
 



VidaOne Diet & Fitness for Windows User’s Guide 68 

9.5. Goals 
VidaOne Diet & Fitness offers you the ability to set and measure a goal. For instance, say you 
set a goal of exercising 350 hours for this year and you want to know how close to this goal you 
are. Choose Goal… from the Fitness  menu to show the Goal window. First define the goal 
(which can be either a target weight gain, target weight loss, duration or distance) and a period, 
and then click Update. The outcome will be displayed in the bottom half of the window.  
 
Figure 54 illustrates such a goal. The chart displays two lines: the first (pale blue) indicates the 
target achievements whereas that second shows t he actual accomplishments. You can precisely 
visualize where you stand with respect to your goal. 
 

 
Figure 54: The Goal window allows you to set and measure a goal. 
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9.6. Calculators 
VidaOne Diet & Fitness provides some popular health calculators: 
 

• Basal Metabolic Rate (BMR), which is the amount of energy your body needs at rest 
for a day, on average. 

• Body Mass Index (BMI), which is a common weight-to-height ration. 
• Lean Body Mass (LBM), which is the amount of your body weight minus the fat. 

 
Choose Calculators… from the Tools menu to show the Calculators window (see Figure 55). 
The values are based on your profile, which you can access from that window by clicking on 
“profile”. 
 
Check off Add the BMR to the Calorie Intake & Expenditure graph in order to add your 
BMR to the calories your burn during your workouts. 
 

 
Figure 55: The Calculators window allows you determine some common measures. 
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9.7. Exporting Data 
You can export workout and health records into a CSV file, which is directly readable by 
Microsoft® Excel®. To export the data, choose Export from the File menu to show the Export 
window (see Figure 56). Choose the file the export to (it must have the CSV extension), the 
period and the type of records (workouts and/or health records) to export, and click Export. 
 

 
Figure 56: The Export window. 
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9.8. Backup and Restore 
VidaOne Diet & Fitness has the ability to backup the workout and health database and restore it 
if needed. We recommend that you make a backup periodically (once a week) as it only takes a 
few seconds. Should the VidaOne Diet & Fitness database become corrupted, VidaOne Diet & 
Fitness allows you to restore it from a previous backup. 

Making a Backup 
To make a backup of your database, choose Backup from the File menu. This will show the 
Backup window (Figure 57). Enter the directory where the backup database is to reside (click 
the “…” button to select a directory if required). Then click OK. The database (a file called 
vodfdb.mdb) will be saved to the specified directory. The file name is vodfdb_date.mdb. 
 

  
Figure 57: The Backup window. 

 
The backup contains the following: 
 

• All meals for all profiles 
• All workouts for all profiles 
• All health records for all profiles 
• All intervals, courses, exercises, and locations for all profiles 

 
The backup does not contain the following: 
 

• Profile description. 
• Some personal settings, options, and training zones. 

Restoring a Backup 
Should you have to restore the data, choose Restore from the File menu. You will be prompted to 
select a vodfdb_date.mdb file (saved by a previous backup). Finally, you will be asked to 
confirm whether you want to restore the data or cancel the operation. Upon confirming, the data 
will be restored. 
 

Click this button to  open a 
window that allows you to 
choose a directory.
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10. Options  
The Options setting allow you to personalize and customize VidaOne Diet & Fitness. The 
options are available by clicking Options from the Tools menu.  
 
Note that since VidaOne Diet & Fitness uses your computer’s regional settings for date and time, 
there is no option to modify their display settings from within VidaOne Diet & Fitness. 

10.1. My Profile  
The profile consists of personal data to enable the calculation of the calories you burn when 
exercising and to establish your initial training zones. 
 

• Enter your personal information: 
o Your gender. 
o Your weight, either in lbs or kg, based on the measurement unit setting., which 

you can set below. 
o Your birth year. 
o Your height, either as m/cm or ft/in, based on the measurement unit setting, which 

you can set below. 
 

• Choose Use 1 decimal for body weight to allow using one decimal with your body 
weight (e.g., 135.4 lbs, or 58,3 kg), as opposed to whole numbers (e.g., 135 lbs or 58 kg). 

 
• Enter your activity level. 

 
• Choose the default measurement units, either English or Metric. You can still choose 

any unit at any time, and VidaOne Diet & Fitness will automatically convert the data as 
needed.  
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10.2. Display Options 
Numerous display options are available. These options affect how graphs and views are 
displayed.  The options are grouped in three categories, listed below. 

Graphs Options 
• Choose Use 3D graphics to use a 3D effect when displaying graphs. Note that some 

graphs do not use 3D effects.  
 
• Choose Zoom graphics to narrow the range of the graphs' vertical axis. If this is 

unchecked, the range starts at zero.  
 

• Choose Show average when applicable to display a dotted line representing the average 
on column or line graphs that show 2 or more values. 

 
• Choose Show total duration on cardio charts to display the total duration (sets * 

duration) for cardio (interval) charts. If this is unchecked, only the workout duration is 
shown. 

 
• Choose Show total weight on strength charts to display total weight (sets * reps * 

weight) for strength (exercise) charts. If this is unchecked, no total weight is shown. 

View Options 
• Choose Show activity names activity lists to display activity names next to the workout 

icons on various lists. If this is unchecked, only the icons are shown. 
 

• You can choose to display or not emoticons (“smileys”) for workouts ratings and health 
mood. 

Other Display Options 
 

• Choose  Adjust BMR for the time of the day for VidaOne Diet & Fitness to perform 
energy calculation using the current time, instead of for the whole day. For instance, if 
selected, the BMR at noon will be half than if the option was not selected. 
 

• Choose Show percent daily value (%DV) to show the %DV whenever nutrients are 
displayed, in various views, lists, and graphs. 
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10.3. Theme Options 
You can select a color theme among pre-defined themes (a few snapshots are shown below), or 
you can define your own custom theme. 
 
Standard 

 
 

Desktop (based on your actual desktop colors) 

 

Brick 

 
 

Lilac 

 

Olive Pumpkin 
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10.4. Customize Options  
Various options are available to customize workouts and energy calculation 
 

• Select the first day (Saturday, Sunday or Monday) of your training week. All views take 
this first day into account week when displaying workouts. For instance, choosing This 
Week in the Report view results in the list of workouts for the week, starting on the 
specified day. If you are unsure, select Monday (most training plans start on Mondays). 

 
• Check Use seconds with workout duration if you want to specify seconds when 

entering workouts' durations.  
 
• Check Use previous workout sets upon adding a workout in order to automatically 

carry over the most recent  workout sets (interval or strength sets) when adding a 
workout.  

 
• Check Use 2 decimals with distance in order to enter precise distances, such as 1.75 mi. 

The default is one decimal (e.g. 1.5 mi). 
 

• You can increase or decrease the energy calculated for your BMR and workouts. For 
instance, if the calculated BMR is too low, you can increase the calculation by 10% by 
entering 10 below. You can also enter a negative value to reduce it if it is too high. 

10.5. Polar Heart Rate Monitor  
You can configure how the connection is established with your heart rate monitor. You can 
choose the connection port (serial or USB) and the interface. 
 
Click the Test button to ensure that the connection parameters are correct and that a connection 
can be established with the heart rate monitor. Note that when testing the connection via 
SonicLink, first select your monitor then click the Test button. 
 
You specify the default location of the HRM files by entering a directory. Click Use Default to 
use the default directory. 

10.6. Nutrients 
Select the nutrients that you want to track. Only those nutrients will be available and displayed 
throughout this application, instead of the full list of nutrients. 

10.7. Markers 
Select the blood markers that you want to track. Only those markers will be available and 
displayed throughout this application, instead of the full list of markers. 

10.8. Other 
The Other page allows you to select an image to be shown at startup (or none) and enable 
security (see section 3.3 about profile confidentiality). 
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Information messages that were turned off can be shown again by choosing Show All. 
 
You can also specify the synchronization with a Windows Mobile Pocket PC device: 

 
• Choose Use my profile when synchronizing if you are using a Pocket PC and/or Palm 

OS handheld and you want to synchronize your workouts with it. 
 

• Choose Synchronize only the past month(s) of data (Pocket PC only) to limit the 
amount of data that is kept on your Pocket PC. This is a powerful feature to keep all your 
records on your desktop, but only a subset of it on your Pocket PC in order to save 
storage space. This also speeds up the synchronization process since less data need to be 
synchronized. Choose the period of time (in months) which the data is kept for, on the 
Pocket PC. For instance, if you choose 6 months, only the data for the past 6 months will 
be synchronized with the Pocket PC, whereas all the data will remain available on the 
desktop. 


